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Overview 
Welcome to the Tolerance Analysis of Deformable Assembly User's Guide!
This guide is intended for users who need to become quickly familiar with the product. 

This overview provides the following information:

●     Tolerance Analysis of Deformable Assembly in a Nutshell

●     Before Reading this Guide

●     Getting the Most Out of this Guide

●     Accessing Sample Documents

●     Conventions Used in this Guide 

Tolerance Analysis of Deformable Assembly in a Nutshell

Tolerance Analysis of Deformable Assembly  product makes it possible to define and analyze the 
assembly process of components. This application offers a highly productive tolerance analysis of assembly 
processes with multiple visualizations and analyses for each of them. 
The information contained in this guide is specific to the Tolerance Analysis of Deformable Assembly 
workbench.

This product is compliant with the Cache Management option set off only, also known as Design Mode.

This product is dedicated to analyzing assembly components as V4 model documents containing a mesh, 
mesh compatible or incompatible with them or with resources may be analyzed, or V5 surfacic part 
documents where external view and material are specified. Functional Tolerancing & Annotation specifications 
on V5 shape part documents may be taken into account through an interpretation of tolerances, see 
Tolerancing options.

This product allows you now to analyze assembly components as V5 solid part documents, but in this 
particular case, their Functional Tolerancing & Annotation specifications are not taken into account. 

This product is able to read and save V5 process documents based on P.P.R. (Process, Product, Resources) 
structure and P.P.R. Hub structure.

●     The Processes List contains processes made of assembly activities:
❍     Positioning.

❍     Fastening.

❍     Already done fastening.

❍     Release.

●     The Products List contains:
❍     The assembly components.



❍     The parts which contain reference points for tolerance analysis features between assembly 
components.

●     The Resources List contains:
❍     The supports as assembly on tooling.

The parts which contains reference points for tolerance analysis features between an assembly component 
and its supports.

Before Reading this Guide

Before reading this guide, you should be familiar with basic Version 5 concepts such as document windows, 
standard and view toolbars. Therefore, we recommend that you read the Infrastructure User's Guide that 
describes generic capabilities common to all Version 5 products. It also describes the general layout of V5 and 
the interoperability between workbenches.

You may also like to read the following complementary product guides, for which the appropriate license is 
required:

●     Product Structure

●     Part Design

●     Assembly Design

●     Generative Shape Design

●     Generative Structural Analysis

●     Functional Tolerancing & Annotations

Getting the Most Out of this Guide

To get the most out of this guide, we suggest that you start reading and performing the step-by-step Getting 
Started tutorial.

Once you have finished, you should move on to the User Tasks section, which deals with handling all the 
product functions.

The Workbench Description section, which describes the Assembly Design workbench, and the Customizing 
section, which explains how to set up the options, will also certainly prove useful.

Navigating in the Split View mode is recommended. This mode offers a framed layout allowing direct access 
from the table of contents to the information.

Accessing Sample Documents

http://canezou/AwsDocV5R14/Doc/online/bascutaa_C2/bascutaa0000.htm


To perform the scenarios, sample documents are provided all along this documentation. For more information 
about this, refer to Accessing Sample Documents in the Infrastructure User's Guide.



Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and 
understand important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task



functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode

Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or the Advanced Tasks

Workbench Description

Customizing

Reference

Methodology

Glossary

Index



Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.

●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document 
window, ...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)



What's New?

Enhanced Functionalities

Editing Tolerance Analysis Images
The Image Edition dialog box has been modified and new options have been added.



Getting Started

Before we discuss the detailed instructions for using the Tolerance Analysis of Deformable Assembly 
workbench, the following scenario aims at giving you a feel for what you can do with a Compliant 
Assembly. You just need to follow the instructions as you progress.

The Getting Started section is composed of the following tasks:

This scenario should take about 30 minutes to complete.



Entering the Workbench

This first task shows you how to enter the Tolerance Analysis of Deformable Assembly workbench.

1.  Select Start -> Analysis & Simulation -> Tolerance Analysis of Deformable Assembly command 

to launch the workbench.

 

The Tolerance Analysis of Deformable Assembly workbench is opened and an empty CATProcess 
document opens.



Creating a New Analysis

This task will show you how to create a new analysis.

1.  Click the New Analysis icon: 

 

2.  Select the Process process in the specification tree.

The Tolerance Analysis of Deformable Assembly objects list appears in the specification 
tree.





Importing Tolerance Analysis Data

This task will show you how to import tolerance analysis data.

Make sure that the following documents are in the same folder:

 TaaData02.txt

 PlateOne.CATPart

 PlateTwo.CATPart

 CurvedPlate.CATPart

1.  Click the Import Data icon: 

2.  Select the TaaData02.txt file in the Open dialog box and click OK.

The Import Tolerance Analysis Data window appears while the data is being loaded.

The tolerance analysis data is loaded. The data contained in this document is: 

Assembly process.

http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/TaaData02.txt
http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/PlateOne.CATPart
http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/PlateTwo.CATPart
http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/CurvedPlate.CATPart


Components defining the assembly.

The tolerance analysis resources.



Tolerancing elements:

 Supports.

 Mechanical joints.

 Positioning systems.

 Fastenings.

 Contacts.

 Annotations.

 Annotation bags.

The assembly to be analyzed looks like this. 



 



Computing a Tolerance Analysis

This task will show you how to compute a tolerance analysis activity.

1.  Click the Compute icon: 

The Compute dialog box appears. 

2.  Select the Release.1 activity in the process list.



3.  Click OK.

The Computation progress bar appears while the tolerance analysis is being computed.
The Release.1 activity is computed.

The previous activities of the selected activity are computed too.
Computed results are not visible.
Contact links are created.



Visualizing a Tolerance Analysis

This task will show you how to visualize tolerance analysis activities.

1.  Click the Visualization icon: 

The Visualization Definition dialog box appears.

2.  Click on the Release.1 activity in the process list to visualize it.



3.  Select View -> Render Style -> Customize View.

The Custom View Modes dialog box appears. 

4.  Select the options as displayed in the Custom View Modes dialog box and click OK.

5.  Click the Visualization icon: 



The assembly looks like this: Assembly components after computation appear with their 
deformations. 

The Translational displacement magnitude tool displays the deformations scale. 

 



6.  Click on the Plate One component to visualize its input tolerances.

Input tolerances are visualized.  

7.  Click on the Release.1 activity to visualize it again.



 You can visualize any activity previous the selected only.

8.  Click OK.



Modifying the Assembly

This task will show you how to modify the assembly, add a new component and modify the 
TasResources component.

1.  Select Edit -> Links...

 

 
2.  In the Links window, double-click TaaRootProduct: the TaaRootProduct product 

document is opened in a new window.

 
3.  In the product document, right-click TaaRootProduct, select Components -> Existing 

Component from the contextual menu and then select the PlateTwo.CATPart document.

 
4.  Close the TaaRootProduct product document.

Note: it is not mandatory to save this document at this stage.

 
5.  Back to the P.P.R. document.

6.  Double-click the Plate Two part document in the Product List to swap to any Part document-

based workbench.

http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/PlateTwo.CATPart


7.  Copy the Support Points open body.

8.  Paste it in the TaaResources part in the Resources List.



9.  Right-click the copy and select the Hide/Show command from the contextual menu.

10.  Double-click Process in the Process List to return to the Tolerance Analysis of Deformable 

Assembly workbench.



Creating Rigid Supports

This task will show you how to create rigid supports.
Supports represent the assembly on tooling. Two kinds of supports are available: rigid or flexible.

1.  Click the Rigid Support icon: 

2.  Select the TasResources product resource from which the support will be created.

The Rigid Support Definition dialog box appears.

3.  Select the Support Points open body.



All the points of the open body are selected. In this case, six points.

4.  Click OK.



Six Rigid Support.13 items are created according to the selected points.



Creating Mechanical Joints

This task will show you how to create mechanical joints.

1.  Click the Mechanical Joint icon: 

2.  Select the Plate Two assembly component as the first element that will be used to create 

the mechanical joint.

The Mechanical Joint Definition dialog box appears.



3.  Select Spherical in the Type combo and check the Set parameters as default option.

4.  Select the Rigid Support.13.1 support as the second component that will be used to create 

the mechanical joint.



5.  Click OK.

Mechanical Joint.13 is created.



6.  Click the Mechanical Joint icon: 

7.  Select the Rigid Support.13.2 support.

8.  Click OK.

9.  Repeat steps 6 to 8 with  the Rigid Support.13.3 to Rigid Support.13.6 supports.

The mechanical joints Mechanical Joint.14 to Mechanical Joint.18 are created. 





Creating Positioning Systems

This task will show you how to create positioning systems.

1.  Click the Positioning System icon: 

The Positioning System Definition dialog box appears.

2.  Select Mechanical Joint.13 to Mechanical Joint.18 in the specification tree.



3.  Click OK.



The Positioning System.5 is created.

4.  Repeat steps 1 to 3 this time, selecting Mechanical Joint.13, Mechanical Joint.14, Mechanical Joint.15.

Positioning System.6 is created.



Creating Spots Welding

This task will show you how to create spots welding.

1.  Click the Spot Welding icon: 

2.  Select Plate Two as the first assembly component that will be used to create the spot 

welding.

The Spot Welding Definition dialog box appears.



3.  Select Plate One as the second assembly component to be used to create the spot welding.

4.  Set the Diameter option to 5 mm.

5.  On Plate Two, select the Fastening Points open body where the spots welding will be 

created.



When more than one point is specified, normal directions are computed for each point as 
being normal to the first component surface on specified points.

6.  Click OK.

The Spot Welding.4.1 to Spot Welding.4.3 items are created.



Creating Contacts

This task will show you how to create a contact.

1.  Click the Contact icon: 

2.  Select the Plate Two assembly component as the first element that will be used to create 

the contact.

The Contact Definition dialog box appears.



3.  Select the Plate One assembly component as the second element that will be used to 

create the contact.

4.  On Plate Two, select the Contact Points open body where the contacts will be created.



5.  Click OK.

Contact.2 is created.

 



Creating a Correlated Deviation

This task will show you how to create an input correlated deviation annotation on an assembly 
component.

1.  Click the Correlated Deviation icon: 

2.  Select the Plate Two assembly component where the annotation will be created.

The Correlated Deviation Definition dialog box appears.



3.  Select Positioning System.6 as the deviation's positioning system.



4.  Select the Deviation Points open body on Plate Two where the annotation will be 

created.





When no measures file is specified in the Statistics Law field, each point of the correlated 
deviation are created according to a normal law with a mean of 1mm and a standard 
deviation of 0.1mm.

5.  Click OK.

Annotation Set.1, Deviations and Deviation Correlated.1 are created.





Creating an Annotation Bag

This task will show you how to create an annotation bag from another one.

1.  Click the Annotation Bag icon: 

2.  Select Deviation.1 to Deviation.4 in TolerancingBag.1.

The Annotation Bag Definition dialog box appears.



3.  Click OK.

Annotation Bag.2 is created.



Adding New Activities

This task will show you how to create new activities describing the assembly process of the Plate 
Two part:

 Positioning of the part.

 Fastening of the part.

 Release of the assembly.

1.  Click the Positioning Activity icon:  

2.  Select the Process process.

The Positioning.2 activity is created.



3.  Click the Fastening Activity icon:  

4.  Select the Process process.

The Fastening.4 activity is created.



5.  Click the Release Activity icon:  

6.  Select the Process process.

The Release.2 activity is created.



Adding new activities does not create process links.



Linking New Activities

This task will show you how to create links between new and existing activities.

1.  Click the Open PERT Chart icon: 

2.  Select the Process process.

The Process PERT Chart window is opened. It displays process activities and their links.



3.  Right-click the link between Release.1 and Stop.1 and select the Delete command from the 

contextual menu.

 



The link is deleted. 

 

4.  Drag and drop Positioning.2, Fastening.4, Release.2 and Stop.1 activities.

 



 

5.  Click the Link between activities icon:  

6.  Select, in the following order, the Release.1, Positioning.2, Fastening.4, Release.2 and Stop.1 

activities. 

New activities are linked.

 



7.  Close the Process PERT Chart window. 

New activities are linked in the specification tree too.



Assigning Items to Activities

This task will show you how to assign items to process activities.

1.  Click the Item Assignment icon:  

2.  Select the Positioning.2 and Fastening.4 activities.

3.  Select the PositionSys.1 positioning system.



The PositionSys.1 positioning system is assigned to the Positioning.2 and Fastening.4 
activities.

4.  Re-click the Item Assignment icon:  

5.  Select the Positioning.2 and Fastening.4 activities.



6.  Select the Positioning System.5 positioning system.

The Positioning System.5 positioning system is assigned to the Positioning.2 and 
Fastening.4 activities.



7.  Re-click the Item Assignment icon:  

8.  Select the Release.2 activity.



9.  Select the Positioning System.6 positioning system.

The Positioning System.6 positioning system is assigned to Release.2 activity.



 

10.  Re-click the Item Assignment icon:  

11.  Select the Positioning.2, Fastening.4 and Release.2 activities.



12.  Select the TolerancingBag.1 tolerancing bag.

The TolerancingBag.1 tolerancing bag is assigned to the Positioning.2, Fastening.4 and 
Release.2 activities.



13.  Re-click the Item Assignment icon:  

14.  Select the SpotWelding.4.1, SpotWelding.4.2, SpotWelding.4.3 spots welding.



15.  Select the Fastening.4 activity.

 

The SpotWelding.4.1, SpotWelding.4.2, SpotWelding.4.3 spots welding are assigned to 
the Fastening.4 activity.





Computing a New Tolerance Analysis

This task will show you how to compute a new tolerance analysis from an added activity.

1.  Click the Compute icon: 

The Compute dialog box appears.

2.  Select the Release.2 activity in the process list.



3.  Click OK.

The Computation progress bar appears during the computation process.
The Release.2 activity is computed.

The previous activities of the selected activity are computed too.
Nothing is visible after computing.
New contact links are created.



Visualizing the New Tolerance Analysis

This task will show you how to visualize tolerance analysis activities.

1.  Click the Visualization icon: 

The Visualization dialog box appears.

2.  Click on the Release.2 activity in the process list to visualize it.



The assembly looks like this: Assembly components after computation appear with their 
deformations.

The Translational displacement magnitude tool displays the deformations scale.





User Tasks
The basic tasks you will perform in the Tolerance Analysis workbench mainly deal with the creation of 
features you will use to define your toleranced assembly.

This section will explain and illustrate how to create these features.
The information you will find is listed below:



Creating a New Tolerance Analysis 

This task will show you how to create a new analysis of assembly tolerance.
An analysis associates the product structure of an assembly document and its component 
tolerances according to an assembly process.
The analysis uses the PPR (Processes, Products, Resources) workbench structure:

 The Process list contains assembly processes or other processes containing tolerance 
analysis activities.
See Defining an Assembly Process.

 The Product list contains imported or created assemblies. Assembly components must 
contain a mesh to be analyzed.

 The Resources list contains geometrical elements used to define the assembly on tooling.

1.  Click the New Analysis icon:  

2.  Select the process in the specification tree.



The Tolerance Analysis of Deformable Assembly objects list appears in the specification 
tree:

 Analysis Manager contains the list of tolerance analyses.

 Supports contains the list of assembly support.

 Mechanical Joints contains the list of assembly mechanical joint.

 Positioning Systems contains the list of assembly positioning systems.

 Fastening Elements contains the list of assembly fastening elements.

 Contacts contains the list of assembly contact.

 Contact Links contains the list of assembly contact links.

 Annotations Bags contains the list of assembly annotations bags.

 



Defining a Tolerance Analysis Assembly

There are two ways to define a tolerance analysis assembly: by importing its components then 
adding tolerance analysis features, or importing tolerance analysis data which may contain 
components, tolerance analysis features, assembly processes.

Import a Mesh: Click this icon, select one or several components. 

Import Data: Click this icon, select the data file. See Tolerance Analysis Data Structure for data file 
structure.



Importing Meshes 

This task will show you how to import a meshed assembly component.
This component must be a mesh contained in a CATIA V4 model.

Open the BasicTaaProcess1.CATProcess document.

The tolerance analysis document looks like this.

1.  Click the Import Mesh icon:  

A product document is added to the product list.

http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/BasicTaa1/BasicTaaProcess1.CATProcess


2.  Select  Product.1 as the product where the new component will be imported: 

3.  Select the Plate.model and CurvedPlate.model documents from the 

samples\BasicTaa1 folder in the Open File dialog box and click OK.

Three documents are created:

 The mesh contained in model document is extracted and stored into a CATAnalysis 
document.

 Computations are stored into a CATAnalysisComputations document.

 Results are stored into a CATAnalysisResults  document.

 



Importing Tolerance Analysis Data 

This task will show you how to import tolerance analysis data.

Depending on the data file content, you may import:

 Assembly

 Assembly + Resources

 Assembly + Resources + Analysis elements

 Assembly + Resources + Analysis elements + Assembly process

See Tolerance Analysis Data reference for further details.

Make sure that the following documents are in the same folder:

 TaaData02.txt

 PlateOne.CATPart

 PlateTwo.CATPart

 CurvedPlate.CATPart

1.  Click the Import Data icon:  

2.  Select the TaaData02.txt file in the Open dialog box and click OK.

The Import Tolerance Analysis Data dialog box appears during the loading process.

The tolerance analysis data is loaded. It consists of the following: 

http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/TaaData02.txt
http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/PlateOne.CATPart
http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/PlateTwo.CATPart
http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/CurvedPlate.CATPart


The assembly process.

See Defining Assembly Process.

The components defining the assembly.



Assembly components may be V5 documents (CATPart, CATProduct) or V4 documents 
(model).

The tolerance analysis resources.

 Analysis elements: 

 Supports.

 Mechanical joints.

 Positioning systems.

 Fastenings.

 Contacts.

 Annotations.

 Annotation bags.



See Creating Tolerance Analysis Elements.

The assembly to be analyzed looks like this: 

 

 



Creating Tolerance Analysis Elements

Tolerance analysis elements define the assembly components behavior between the user and the 
assembly on tooling.

Create a Rigid Support: Click this icon, select the component, select the point to define a rigid 
support. 

Create a Flexible Support: Click this icon, select the component, select the set of points to define a 
flexible support. 

Create a Mechanical Joint: Click this icon, select the two components or the component and its 
support, select the point to define a mechanical joint, choose the joint type. 

Create a Positioning System: Click this icon, select a set of mechanical joints, modify or not the joint 
type definition.

Create a Fastening Element: Click this icon, select a set of components, select the point to define a 
spot welding.

Create a Fastening Element: Click this icon, select a set of components, select the point to define a 
riveting .

Create a Fastening Element: Click this icon, select a set of components, select the point to define a 
bolting.

Create a Fastening Element: Click this icon, select a set of components, select the point to define a 
spot gluing.

Create a Contact: Click this icon, select two components, select the point to define a contact.

 
Linking Contacts: Click this icon, select two components, select the point to define a contact.

Set Parameters as Default 



Creating a Rigid Support 

This task will show you how to create a rigid support.

A rigid support represents the assembly on tooling and it is modelized by a point which mechanical 
rigidity is infinite.
It is not possible to re-use a point already used as a support (rigid or flexible). 
This point may be:

 One, several or all the V5 Points from one or several V5 Open Body.

 One or several V4 mesh nodes from one or several V4 meshes.

A rigid support does not move during the assembly process.
The rigid support is stored in a CATPart document of the resource list.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Rigid Support icon:  

2.  Select the component representing the tooling under the ResourcesList node of the PPR 

tree.

If the ResourcesList node of the PPR tree is empty, a resource product structure will be 
automatically created so that the user can select a resource component. The support created 
will be linked to the component selected.

The Rigid Support Definition dialog box appears. 

http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/BasicTaa2/BasicTaaProcess2.CATProcess


3.  Select the Support Points 2 open body.

All the points of the open body are selected. In this example six points.

4.  Click OK.



Three Rigid Support.20 items are created according to the selected points.



Creating a Flexible Support 

This task will show you how to create a flexible support.

A flexible support represents the assembly on tooling and it is modelized by points which 
mechanical rigidity between us can be quantified.
Selecting one point is equivalent to creating a rigid support.
It is not possible to re-use a point already used as support (rigid or flexible). 
These points may be:

 Several or all the V5 Points from one or several V5 Open Body.

 Several V4 mesh nodes from one or several V4 meshes.

A flexible support can move during the assembly and the analysis.
The flexible support is stored in a CATPart document of the resource list.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Flexible Support icon:  

2.  Select the TasResources product resource from which the support will be created.

The Flexible Support Definition dialog box appears. 

http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/BasicTaa2/BasicTaaProcess2.CATProcess


Three types of flexible supports may be defined: 

User define

For each beam, you must define: 

Kx: compression stiffness along x axis of the beam.
Ky: flexion stiffness along y axis of the beam.
Kz: flexion stiffness along z axis of the beam.
Kt: torsion stiffness around x axis of the beam
DZx: normal direction of the beam along x axis of the part.
DZy: normal direction of the beam along y axis of the part.
DZz: normal direction of the beam along z axis of the part.

Circular

For each beam, you must define: 

Radius: radius of the beam.
Young Module
Poisson Coefficient

Rectangular

For each beam, you must define: 

Base: rectangular base of the beam.
Height: rectangular height of the beam.
DZx: normal direction of the beam along x axis of the part.
DZy: normal direction of the beam along y axis of the part.
DZz: normal direction of the beam along z axis of the part.
Young Module
Poisson Coefficient



3.  Select the Circular type.

4.  Select the Support Points 2 open body.

5.  Select each radius field and specified 5mm.



6.  Specify 2.1e+006 as Young module.

7.  Click OK. 

The Flexible Support.1 is created according to the selected points.



 



Creating a Mechanical Joint 

This task will show you how to create a mechanical joint.

A mechanical joint represents the translations and rotations that are allowed or not between two 
assembly components, or between an assembly component and a support.
During the analysis, only the translations and rotations not allowed are taken into account.
It is not possible to create two mechanical joints at the same location.
See also Setting Parameters as Default to instantiate a mechanical joint.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Mechanical Joint icon:  

2.  Select the Plate Two assembly component as the first element to create the mechanical 

joint.

The Mechanical Joint Definition dialog box appears. 
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Twelve types of mechanical joints may be defined according to the mechanical joint's axis 
definition: 

Point

Translation along x axis is 
locked.

Annular-Linear

Translation along x axis is 
locked.
Translation along z axis is 
locked.

Edge Slider

Translation along x axis is 
locked.
Translation along z axis is 
locked.
Rotation around z axis is 
locked.

Planar



Translation along x axis is 
locked.
Translation along y axis is 
locked.
Translation along z axis is 
locked.
Rotation around y axis is 
locked.
Rotation around z axis is 
locked.

Spherical

Translation along x axis is 
locked.
Translation along y axis is 
locked.
Translation along z axis is 
locked.

Spherical With Pin

Translation along x axis is 
locked.
Translation along y axis is 
locked.
Translation along z axis is 
locked.
Rotation around x axis is 
locked.

Cylindrical

Translation along y axis is 
locked.
Translation along z axis is 
locked.
Rotation around y axis is 
locked.
Rotation around z axis is 
locked.

Screw

Translation along x axis and 
rotation around x axis are 
linked.
Translation along y axis is 
locked.
Translation along z axis is 
locked.
Rotation around x axis is 
locked.
Rotation around y axis is 
locked.
Rotation around z axis is 
locked.

Revolute



Translation along x axis is 
locked.
Translation along y axis is 
locked.
Translation along z axis is 
locked.
Rotation around y axis is 
locked.
Rotation around z axis is 
locked.

Prismatic

Translation along y axis is 
locked.
Translation along z axis is 
locked.
Rotation around x axis is 
locked.
Rotation around y axis is 
locked.
Rotation around z axis is 
locked.

Rigid

Translation along x axis is 
locked.
Translation along y axis is 
locked.
Translation along z axis is 
locked.
Rotation around x axis is 
locked.
Rotation around y axis is 
locked.
Rotation around z axis is 
locked.

3.  Select Spherical in the Type combo.

4.  Select the Support.14 support as the second component to create the mechanical joint.





5.  Click OK.

Mechanical Joint.19 is created.



 



Creating a Positioning System 

This task will show you how to create a positioning system.

A positioning system represents a set of mechanical joints for which you can lock or unlock translations or rotations.
A positioning system is an activity item. See Assigning an Item.
A positioning system has three different states:

 Isostatic: Mechanical joints represent an equilibrium positioning system.

 Constrained: There are too many mechanical joints to represent an equilibrium positioning system.

 Under-constrained: There are not any mechanical joints to represent an equilibrium positioning system.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Positioning System icon:  

The Positioning System Definition dialog box appears. 

2.  Select Mechanical Joint.13 to Mechanical Joint.18 in the specification tree.
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3.  Click OK.

The Positioning System.7 is created. This positioning system is in a constrained state.

 



Creating Fastening Elements 

This task will show you how to create a fastening element.

A fastening element creates a fastening link between several assembly components.
It is not possible to create two fastening elements at the same location.

 A fastening element may be created:

 Between two assembly components.

 Between two adjacent parts to the same assembly component.

 A fastening element is a fastening activity item. See Assigning an Item.

 There are four fastening elements available in Tolerance Analysis of Deformable Assembly:

 
 Spot Welding lets you create a welding link according to Fastening options. See Spot 

Welding settings.

 
 Riveting lets you create a riveting link according to Fastening options. See Riveting 

settings.

 
 Bolting lets you create a bolting link according to Fastening options. See Bolting 

settings.

 
 Spot Gluing lets you create a gluing link according to Fastening options. See Spot 

Gluing settings.

 See also Setting Parameters as Default to instantiate a fastening.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Spot Welding icon: 

2.  Select Plate Two as the first assembly component that will be used to create the spot 

welding.
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The Spot Welding Definition dialog box appears.

3.  Select Plate One as the second assembly component that will be used to create the spot 

welding.



4.  Set the Diameter option in the Spot Welding Definition dialog box to 5 mm, the 

diameter information is not taken into account during the computation, only for 

visualization.

5.  Select the Fastening Points open body on Plate Two where spots welding will be created.





When more than one point is specified, normal directions are computed for each point as  
being normal to the first component surface on specified points.

6.  Click OK.

The Spot Welding.7.1 to Spot Welding.7.4 items are created.



 



Creating a Contact 

This task will show you how to create a contact.

A contact prevents assembly components from clashing from a fastening element: spot welding, 
riveting, bolting, spot gluing.

 A contact may be created:

 Between two assembly components.

 Between two adjacent parts to the same assembly component.

 See also Setting Parameters as Default to instantiate a contact.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Contact icon:  

2.  Select the Plate Two assembly component as first element that will be used to create the 

contact.

The Contact Definition dialog box appears.
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3.  Select the Plate One assembly component as the second element that will be used to 

create the contact.

4.  Select the Contact Points  open body on Plate Two where contacts will be created.





5.  Click OK. 

Contact.3 is created. 

 



Linking Contacts 

This task will show you how to link contacts with a fastening element.

This command is active with the Automatic option unchecked. See Links Creation Mode.

Contact links are taken into account during a computation process for fastening activities. See 
Computing a Tolerance Analysis and Creating a Fastening Element.

 If the Automatic option is checked, contact links around fastening elements are 
automatically created during computation.

 If the Automatic option is unchecked, no contact links around fastening elements are 
created. Only contact links defined by the user are taken into account.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Contact Links icon:  

The Contact Links Definition dialog box appears.
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2.  Select the Spot Welding.4.1 fastening.



3.  Select the contact points.

In the specification tree, you must only select  points already associated with a contact.

4.  Click OK.



Contact Links.1 is created.

 



Setting Parameters as Default

This task will show you how to set parameters creation as default parameters for mechanical joints, 
fastening elements, contacts, then how to re-use them.

This option is available for these commands and allows you to:

Select only a support to create a mechanical joint. Type and first component are the same.
See Creating a Mechanical Joint.

Select only a point or an open body containing points to create a fastening element.
The components and the diameters are the same.
See Creating a Fastening Element. 



Select only a point or an open body containing points to create a contact.
The first and the second component are the same.
See Creating a Contact.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Mechanical Joint icon: 
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2.  Select the Plate Two assembly component as the first element that will be used to create 

the mechanical joint.

The Mechanical Joint Definition dialog box appears. 

3.  Select Spherical in the Type combo and check the Set parameters as default option.

4.  Select the Rigid Support.14 support as the second component that will be used to create 

the mechanical joint.





5.  Click OK.

Mechanical Joint.19 is created.



6.  Click the Mechanical Joint icon: 



 The Type option and the First Component are the same as the previous created 
mechanical joint.

 



Defining Tolerancing

Create a Deviation: Click this icon, select the component, select the point to define a annotation. 

Create a Correlated Deviation: Click this icon, select the component, select the set of point to define 
a correlated annotation. 

 
Create a Distance Between Two Points: Click this icon, select the parent component, select start and 
end points to define a distance between two points annotation

 
Create Analysis Geometric Variations: Click this icon, select the component, select the analysis to 
define a analysis geometric variations annotation.

Create an Annotation Bag: Click this icon, select the set of deviation or correlated deviation to define 
an annotation bag . 



Creating a Deviation   

This task will show you how to create a deviation annotation on an assembly component.

A deviation annotation may be created on an assembly component or a support, see Creating Rigid 
Support and Creating Flexible Supports. 
A deviation annotation represents a specified or measured point according to a statistics law.
The deviation annotation of an assembly component or support is contained in its annotation set:

●     For a leaf assembly component or a support, deviation annotations represent the input 
annotations or initial annotations of the component.

●     For a parent assembly component, deviation annotations represent the output annotations or 
annotations to be verified.

 Note: the output annotations' positioning system is not taken into account during computation, the 
positioning systems being taken into account are the ones associated to the activities.

A deviation annotation is always associated with a positioning system in order to specify how the 
component is positioned when measured:

●     for an input annotation, the variation in the degrees of freedom restrained by the positioning 
system is null by definition.

●     the deviation must not overlap with a degree of freedom used by its positioning system, 
therefore a point already used by a mechanical joint of the positioning system cannot be used 
by the deviation.

This positioning system must:
●     Be isostatic at least.

●     Be associated with the assembly component where the deviation is created.

●     Contain joints between support and the assembly component where the deviation is created.

●     Be empty when creating a deviation on a support.

Component's deviation annotations always have the same positioning system.
See Creating Positioning System.

 Datum reference frame created with the 3D Functional Tolerancing & Annotations workbench may 
be used instead of a positioning system in a deviation.

Clicking the Generate Points command in the Deviation Definition dialog box generates default 
annotation points. These points are typical points where the component is the more flexible.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Deviation icon:  
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2.  Select the Plate Two assembly component.

The Deviation Definition dialog box appears.

 In the Statistics Law tab you can select and define the desired law.
Six laws and their parameters are available:

 Normal law:

 Mean

 Standard Deviation

 Uniform law:



 Minimum Limit

 Maximum Limit

 Constant law:

 Constant

 Pearson law: 

 Nu

 Poisson:

 Lambda

 Snedecor:

 Degrees of freedom m

 Degrees of freedom n

 The Local Deviation option defines whether you to take into account the deviation where it is 
defined or to interpolate it on the assembly component.

3.  Keep the Normal law and the default parameters.

4.  Select Positioning System.6 as the deviation's positioning system.



5.  Select the Deviation Points 2 open body on Plate Two where the annotation will be 

created.





6.  Click OK.



Six deviations are created: from Deviation1.1 to Deviation1.7.

 



Creating a Correlated Deviation   

This task will show you how to create a correlated deviation annotation on an assembly component.

A correlated deviation annotation may be created on an assembly component or a single flexible 
support,
see Creating Flexible Supports.
A correlated deviation annotation represents specified or measured points according to a statistics 
law.
The correlated deviation annotation of an assembly component or support is contained in its 
annotation set:

●     For a leaf assembly component or a support, correlated deviation annotations represent the 
input annotations or initial annotations of the component.

●     For a parent assembly component, correlated deviation annotations represent the output 
annotations or annotations to be verified.

 Note: the output annotations' positioning system is not taken into account during computation, the 
positioning systems being taken into account are the ones associated to the activities.

 A correlated deviation annotation is always associated with a positioning system in order to specify 
how the component is positioned when measured:

●     for an input annotation, the variation in the degrees of freedom restrained by the positioning 
system is null by definition.

●     the correlated deviation must not overlap with a degree of freedom used by its positioning 
system, therefore a point already used by a mechanical joint of the positioning system cannot 
be used by the correlated deviation.

This positioning system must:
●     Be isostatic at least.

●     Be associated with the assembly component where the correlated deviation is created.

●     Contain joints between support and the assembly component where the correlated deviation is 
created.

●     Be empty when creating a correlated deviation on a support.

Component's correlated deviation annotations always have the same positioning system.
See Creating Positioning System.

 Datum reference frame created with the Functional Tolerancing & Annotations workbench may be 
used instead of a positioning system in a deviation.

Clicking the Generate Points command in the Deviation Definition dialog box generates default 
annotation points. These points are typical points where the component is the more flexible.

Open the BasicTaaProcess2.CATProcess document.
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1.  Click the Correlated Deviation icon:  

2.  Select the Plate Two assembly component.

The Correlated Deviation Definition dialog box appears.



In the Statistics Law frame you can select a measurement file to define the correlated 
deviation law.
When no measures file in the Statistics Law field is specified, each point of the correlated 
deviation is created according to a normal law with a mean of 1mm and a standard 
deviation of 0.1mm.
See Measurement Data.

 The Local Deviation option allows you to take into account the deviation where it is 
defined or to interpolate it on the assembly component.

3.  Keep the Normal law and default parameters.

4.  Select Positioning System.6 as the deviation's positioning system.



5.  Select the Deviation Points 2 open body on Plate Two where the annotation will be 

created.





6.  Click OK.



Deviation Correlated.2 is created.

 



Creating a Distance Between Two Points   

This task will show you how to create a distance between two points annotation between two points 
of an assembly component or two assembly components.

Distance between two points annotation represents a distance to be checked between two points.
The distance between two points annotation of an assembly component is contained in the 
component's annotation set.
Distance between two points annotation represent the an output annotation or an annotation to be 
verified.

 A distance between two points annotation is already associated with a positioning system or a 
datum reference frame.

This positioning system must:

 Be isostatic at least.

 Be associated with the assembly component where the distance between two points is 
created.

 Contain joints between support and the assembly component where the distance between 
two points is created.

 Be empty when creating a distance between two points on a support.

Component's annotations always have the same positioning system.
See Creating Positioning System.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Distance Between Two Points icon:  

2.  Select the BasicTaaAssembly2 assembly component.
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The Distance Between Two Points dialog box appears.

In the Statistics Law tab you can select and define the desired law.
Six laws and their parameters are available:

 Normal law:

 Mean

 Standard Deviation

 Uniform law:

 Minimum Limit

 Maximum Limit

 Constant law:



 Constant

 Pearson law: 

 Nu

 Poisson 

 Lambda

 Snedecor 

 Degrees of freedom m

 Degrees of freedom n

3.  Keep the normal law and the default parameters.

4.  Select PositioningSys.3 as the deviation's positioning system.

5.  Select Point.61 in Plate Two as the starting point.



6.  Select Point.67 in Plate Two as the end point.





7.  Click OK. 



Distance Point Point.1 is created.

 



Creating Analysis Geometric Variations 

This task will show you how to create analysis geometric variations annotation into a parent 
component.

A analysis geometric variations annotation represents an input annotation generated from an 
analysis.
You may retrieve this analysis by:

●     selecting an analysis solution object in the specification tree (activate the CATAnalysis shape 
representation before), this analysis might be all single occurrence solutions such as Static case 
or Combined case from Generative Structural Analysis workbench, or from any workbenches 
based on Version 5 CATAnalysis documents.

●     importing a text file containing the analysis solution (the file text format must be Text, not 
Unicode Text).

The analysis geometric variations annotation of an assembly component is contained in the 
component's annotation set.

Open the BasicTaaProcess2 CATProcess document.

1.  Click the Analysis Geometric Variations icon:  

2.  Select the CurvedPlate assembly component.

The Analysis Geometric Variations Definition dialog box appears.
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In the Statistic Law tab you can define the desired law.
One law and its parameters is available:

●     Percentage

❍     Scale

❍     Percentage

❍     Mean (read only)

❍     Standard Deviation (read only)

❍     Tolerance Interval (read only)

3.  Click the browse ... button and select DispFieldForCurvedPlate.txt file to import an analysis.
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4.  Click OK.



The Analysis Geometric Variations.1 is created.

 



Creating Annotation Bags   

This task will show you how to create an annotation bag.

An annotation bag contains all or some annotations of a component's annotation set.
An annotation bag is an activity item. For more information, see Assigning an Item.
Annotations may be selected from an existing annotation bag.

 Tolerancing capture created with the 3D Functional Tolerancing & Annotations workbench may be 
used instead of an annotation bag in an activity, in this case, only annotations which are shown in 
the capture are taken into account to define the annotation bag.

1.  Click the Annotation Bag icon:  

2.  Select the deviations from Deviation.1 to Deviation.4 in TolerancingBag.1.



The Annotation Bag Definition dialog box appears. 



3.  Click OK.

Annotation Bag.2 is created.

 



Defining an Assembly Process

Tolerance analysis is computed from assembly process activities.
The assembly process is made of a set of only four activity types: Positioning, Fastening, Already 
Done Fastening and Release.
Activities must be linked between them and items assigned to defined the activity.
Process activities may be a combination of linear and/or parallel sequences.

Add an Activity: Click this icon, select the process.

Add an  Activity: Click this icon, select the process.

Add an Activity: Click this icon, select the process.

Add an Activity: Click this icon, select the process.

 
Link Activities: Click this icon, select the activities.

Manage Items: Click this icon, select an item then select the activity.

Manage Items Click this icon, select the activity then select the items.



Adding an Activity 

This task will show you how to create a process activity.

Adding a new activity does not create a process link, see Linking Activities,
and items must be defined to an activity, see Assigning an Item.
There is no sub-activity under an activity.
There are four process activities available in the workbench:

 
 Positioning activity positions in 3D space assembly components to be fastened.

 
 Fastening activity fastens assembly components according to a positioning activity and 

takes into account assembly components move during fastening.

 
 Already Done Fastening activity fastens assembly components according to a 

positioning activity and does not take into account assembly components move during 
fastening.

 
 Release activity release the assembly components according to fastening activity.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Release Activity icon:  

2.  Select the BasicTaaProcess2 process.
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The Release.4 activity is created.



 



Linking Activities

This task will show you how to create and remove links between activities.

The Process PERT Chart window displays process activities and their links.
This window is another representation of the specification tree process list.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Open PERT Chart icon:  

2.  Select the BasicTaaProcess2 process.

The Process PERT Chart window is opened.
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2.  Right-click the link between Release.1 and Stop.1 and select the Delete command from the 

contextual menu.

 



The link is deleted.

 

3.  Drag and drop Release.3 and Stop.1 activities.

 



 

4.  Click the Link between activities icon:  

5.  Select, in the following order, Release.2, Release.3 and Stop.1 activities. 

New activities are linked.

 



6.  Close the Process PERT Chart window. 

New activities are linked in the specification tree too.

 

 



Managing Items

This task will show you how to assign or un-assign items to process activities.

You must assign items to compute an analysis:

 One or several Positioning System or Datum Reference Frame to all activities. See Creating 
Positioning System.

 Fastening only  to a Fastening or Already Done Fastening activity. See Creating Fastening.

 Annotation Bag or Tolerancing capture to all activities. See Creating Annotation Bag.
You can assign one or more Annotation Bag/Tolerancing capture but only one will be take 
into account with the following rule: the first Annotation Bag then the first Tolerancing 
capture in the item's list.

 The first Annotation Bag then the first Tolerancing capture in the list is take into 
account.

 The first item in the list is take into account.

You may assign:

 An item to several activities.

 Several items to an activity.

You may un-assign:

 Several items from an activity.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Item Assignment icon:  

2.  Select Positioning System.6 and TolerancingBag.1 items.
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3.  Select the Release.3 activity.



Positioning System.6 and TolerancingBag.1 are assigned to the Release.3 activity.



4.  Click the Unassign an item icon:  

5.  Select the Release.3 activity.



The Items dialog box appears. 



6.  Select TolerancingBag.1 item in the dialog box.

7.  Click Unassign. 

TolerancingBag.1 is un-assigned from Release.3 activity.

 



Tolerance Analysis

Tolerance analysis is computed from an assembly process activity. The assembly process is made of 
a set of only three activity types: Positioning, Fastening and Release.

 
Report: Click this icon, select a tolerance analysis element..

 
Compute: Click this icon, select an activity.

 
Visualization : Click this icon, select an activity.

 
Analysis: Click this icon, select an activity



Reporting Tolerance Analysis Elements 

This task will show you how to show a html report from a list of tolerance analysis elements.

The lists of tolerance analysis elements available are:

Supports

Mechanical Joints

Positioning Systems

Fastening elements

Contacts

Contact Links

Annotations Bags

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Report icon:  

2.  Select the Supports list of tolerance analysis support..

A html document is open. It contains the list of tolerance analysis support and their 
validity.
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Computing a Tolerance Analysis 

This task will show you how to compute tolerance analysis activities.

The previous activities of the selected activity are computed too.
Nothing is visible after computing.
New contact links are created when the Automatic option is checked. See Links Creation Mode.

Selecting the Report option in the Compute dialog box generates a html file containing the 
compute report.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Compute icon:  

The Compute dialog box appears.

2.  Select the Release.2 activity in the process list.
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3.  Click OK. 

The Computation progress bar appears.

The Release.2 activity is computed.

 



Visualizing Tolerance Analysis Results 

This task will show you how to visualize tolerance analysis activities.

A visualize tolerance analysis displays assembly deformations or initial deformations of any 
assembly's component according to the selected activity.
You can only visualize computed activities.
See Computing Tolerance Analysis.

Open the BasicTaaProcess2.CATProcess document.

1.  Compute the Release.2 activity. See Computing Tolerance Analysis.

2.  Click the Visualization icon:  

The Visualization dialog box appears.

Clicking the Report button in the visualization dialog box generates a html file containing 
the compute report.

In the Kind of Visualization frame you can define the desired visualization:
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●     Determinist

❍     Mean

❍     Normal display or Residual Stress

●     Statistics

❍     Mean or Mean minus three standard deviations or Mean plus three standard 
deviations

❍     Normal display or Residual Stress

 Three delta analyses are available:

 
●     Absolute

●     Product Delta

●     Activity Delta

3.  Select View -> Render Style -> Customize View.

The Custom View Modes dialog box appears. 

4.  Select the options as displayed in the Custom View Modes dialog box and click OK.



5.  Click the Visualization icon: 

6.  Click on the Release.2 activity in the process list to visualize it.

The assembly looks like this: Assembly components after computation appear with their 
deformations. 



The Translational displacement magnitude tool displays the deformations scale.

7.  Click on Plate One to visualize its input tolerances.



Input tolerances are visualized.

8.  Click on Release.2 activity to visualize it again.



9.  Select Residual Stress.



Residual Stresses are displayed in the assembly.

The  Von Mises Stress tool displays the deformations scale.



 



Displaying Tolerance Analysis Results 

This task will show you how to display tolerance analysis activities.

The Analysis Data command displays assembly deformations or initial deformations of any assembly's component according to the 
selected activity. 
You can only report computed activities.
See Computing Tolerance Analysis.

Open the BasicTaaProcess2.CATProcess document.

1.  Compute the Release.2 activity. For more information, see Computing a Tolerance Analysis.

2.  Click the Analysis Data icon:  

The Analysis Results dialog box appears.

Four analyses are available:

 
●     Determinist

●     Statistics

●     Statistics All Direction

●     Worst Case

 Three delta analyses are available:

 
●     Absolute

●     Product Delta

●     Activity Delta

Three results are available:
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●     Annotations

●     Forces

●     Stiffness

3.  Click on the Release.2 activity in the process list to display it.

 



Editing Tolerance Analysis Images 

This task will show you how to display tolerance analysis images.

This command allows you to display analysis images for all assembly components associated with 
an activity. You can edit a tolerance analysis image of an activity only after you are performing a 
visualization of this activity, see Visualizing Tolerance Analysis Results.
For more detail about the new Image Edition dialog box options, see Image Edition Dialog Box 
and Advanced Edition for Images and Local Sensors.

Open the BasicTaaProcess2.CATProcess document.

1.  Compute the Release.2 activity. See Computing Tolerance Analysis.

2.  Click the Visualization icon:  

3.  Select the Release.2 activity and click OK in the Visualization dialog box.

4.  Click the Edit Images icon:  

5.  Select the Release.2 activity.

The Image Edition dialog box appears.
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6.  Select the desired options for display.

 



Saving Tolerance Analysis Documents

This task will show you how to save tolerance analysis documents.

1.  Click the File -> Save All As... command.

The Save All As dialog box appears.



Exporting Data

This task will show you how to export tolerance analysis data.

The data structure of the exported file is the same as the tolerance analysis data structure. It will 
be possible to import the text file using Import Data command of the workbench, see Importing 
Tolerance Analysis Data and Tolerance Analysis Data.
Note that only specifications that can be imported are exported in the text file (e.g. non Tolerance 
analysis data, as Analysis Geometric Variations, or Contact Links are not exported).

 The file header of the exported file is not customizable:  Notice that the version of the exported file 
is a new version of the data file (51300). Constraints directions are dumped in the data file. 

 <TaaData> Version: 51300
Mode: English
ModelPath: Absolute
LengthUnit: Millimeter
ForceUnit: Newton
...
<EndTaaData>

 
●     The data structure must contain:

❍     Only one root product.

❍     Only one root resource.

●     TasPointPart and TasResources files are not exported (they are created when importing the 
data).

●     If exported CATPart document contains Tolerance analysis annotations, you must delete these 
annotations in the text file generated.

●     This functionality is standalone in this application.

Open the BasicTaaProcess2.CATProcess document.

1.  Click the Export Data icon:  

The Export dialog box appears.

2.  Specify the folder and file name where to export the file and click Save.

http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/BasicTaa2/BasicTaaProcess2.CATProcess


Handling Inconsistent Model Set Up

 These tasks described you a list of inconsistency in the Tolerance Analysis of Deformable Assembly 
model set up, which can be raised during the computation.

 Rigid-Body Motion Singularity Restitution

 Over-Constrained Singularity Restitution

 Meshing Connection Error

 



Rigid-Body Motion Singularity Restitution

This task will show you how to visualize a rigid-body motion singularity.
This singularity is a global singularity type.

●     If singularity error exists, it is raised during the computation only.

●     If several singularity errors exist, they can be raised only one by one.
This means that you must correct the singularity and re-run the computation to encounter the next 
singularity if exists.

Open the RigidBodyMotion CATProcess document.

1.  Click the Compute icon: 

The Compute dialog box appears.

 
2.  Select the POSITIONING.1 activity in the process list. 

3.  Click OK.

 The Error dialog box appears during the computation.

 

http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/Singularity-RigidBodyMotion-Activity/RigidBodyMotion.CATProcess


4.  Click OK.

 

5.  Click the Visualization icon: 

The Visualization dialog box appears.

 
6.  Select the POSITIONING.1 activity in the process list. 

 The rigid-body motion singularity is visualized.

 



7.  Click OK.



Over-Constrained Singularity Restitution

This task will show you how to visualize an redundant constraint singularity (locally over-constrained) 
generated by mechanical joints, fastenings, contacts.
This singularity is a local singularity type.

●     If singularity error exists, it is raised during the computation only.

●     If several singularity errors exist, they can be raised only one by one.
This means that you must correct the singularity and re-run the computation to encounter the next 
singularity if exists.

Open the OverConstrained CATProcess document.

1.  Click the Compute icon: 

The Compute dialog box appears.

 
2.  Select the POSITIONING.1 activity in the process list. 

3.  Click OK.

 The Error dialog box appears during the computation.

http://canezou/AwsDocV5R14/Doc/online/taaug_C2/samples/Singularity-OverConstrained-Activity/OverConstrained.CATProcess


 

4.  Click OK.

 

5.  Click the Visualization icon: 

The Visualization dialog box appears.

 
6.  Select the POSITIONING.1 activity in the process list. 

7.  Click OK.



 

8.  Click the Edit Images icon:  and select the POSITIONING.1 activity in the process list.

The Image Edition dialog box appears. See Displaying Tolerance Analysis Images.

 
9.  Select the SYMBOL type and uncheck the Display on deformed mesh option.

 The over-constrained singularity is visualized with red arrows.

 



10.  Click OK.



Meshing Connection Error

After a computation, you may encounter an error message raised by the meshing connection 
operation.
This message indicates that the application was not able to generate some interpolation elements 
corresponding to some specifications (spec name / point name).

●     This message occurs when the specification is invalid or when the Maximum  distance 
between geometry and point value is too small for the specification. See Meshes option.

●     When facing this problem, the Edit/Find functionality can be used to get a hand on the 
specification mentioned in the message. Reframe on and edition (through double-click) are 
then used to identify the problem.



Workbench Description
The Tolerance Analysis of Deformable Assembly workbench looks like this (move the mouse over image's links and 
have the enlarged image and corresponding description pop up):



Tolerance Analysis of Deformable Assembly Menu 
Bar

This section presents the main menu bar available when you run the application and before creating or opening 
a document:

Start File Edit View Insert Tools Windows Help

Insert
For... See...

New Analysis
Creating a New Tolerance 
Analysis

Import Mesh... Importing Meshes

Import Data...
Importing Tolerance Analysis 
Data

Supports Insert Supports Menu

Mechanical Joint... Creating a Mechanical Joint

Positioning System... Creating a Positioning System

Fastening Elements Insert Fastening Elements Menu

Contacts Insert Contacts Menu

Annotations Insert Annotations Menu

Annotations Bag... Creating Annotation Bags

Activities Insert Activities Menu

Tools



For... See...

New Analysis
Creating a New Tolerance 
Analysis

Import Mesh... Importing Meshes

Import Data...
Importing Tolerance Analysis 
Data



Insert Supports Menu
This section presents the Insert Supports menu:

Insert -> Supports 
For... See...

Rigid 
Support 

Creating a Rigid Support

Flexible 
Support 

Creating a Flexible Support

 



Insert Fastening Elements Menu
This section presents the Insert Fastening Elements menu:

Insert -> Fastening Elements 
For... See...

Spot 
Welding... 

Creating Fastening Elements

Riveting... Creating Fastening Elements

Bolting... Creating Fastening Elements

Spot Gluing... Creating Fastening Elements

 



Insert Contacts Menu
This section presents the Insert Contacts menu:

Insert -> Contacts 
For... See...

Contacts... Creating a Contact

Contact 
Links... 

Linking Contacts

 



Insert Annotations Menu
This section presents the Insert Annotations menu:

Insert -> Annotations 
For... See...

Annotations... Creating a Deviation

Correlated 
Annotations... 

Creating a Correlated Deviation

Distance Between Two 
Points... 

Creating a Distance Between Two 
Points

Analysis Geometric 
Variations... 

Creating Analysis Geometric 
Variations

 



Insert Activities Menu
This section presents the Insert Activities menu:

Insert -> Activities 
For... See...

Positioning Activity Adding an Activity

Fastening Activity Adding an Activity

Release Activity Adding an Activity

Already Done Fastening 
Activity 

Adding an Activity



Tools Computed Results Menu
This section presents the Tools Computed Results menu:

Tools -> Computed Results 
For... See...

Visualization... Visualizing Tolerance Analysis Results

Analysis 
Data... 

Displaying Tolerance Analysis Results

Edit Images... Displaying Tolerance Analysis Images

 



Analysis Toolbar 

 
See Creating a New Tolerance Analysis 

 
See Importing Meshes 

See Importing Tolerance Analysis Data 

See Exporting Data 



Elements Toolbar  

 
Jump to Supports Sub-Toolbar

 
See Creating a Mechanical Joint 

 
See Creating a Positioning System 

 
Jump to Fastening Elements Sub-Toolbar

 
Jump to Contacts Sub-Toolbar

 
Jump to Annotations Sub-Toolbar

 
See Creating Annotation Bags 

Supports Sub-Toolbar

 
See Creating a Rigid Support 

 
See Creating a Flexible Support 

Fastening Elements Sub-Toolbar



 
See Creating Fastening Elements 

 
See Creating Fastening Elements 

 
See Creating Fastening Elements 

 
See Creating Fastening Elements 

Contacts Sub-Toolbar

 
See Creating a Contact 

 
See Linking Contacts 

Annotations Sub-Toolbar

 
See Creating a Deviation 

 
See Creating a Correlated Deviation 

See Creating a Distance Between Two Points 

 
See Creating Analysis Geometric Variations 



Process Toolbar 

 
See Linking Activities 

See Managing Items 

See Managing Items 

 
See Linking Activities 

 
Jump to Activities Sub-Toolbar

Activities Sub-Toolbar

 
See Adding an Activity 

 
See Adding an Activity 

See Adding an Activity 

 
See Adding an Activity 



Tools Toolbar 

See Reporting Tolerance Analysis Elements 

 
See Computing Tolerance Analysis 

 
Jump to Computed Results Sub-Toolbar

Computed Results Sub-Toolbar

 
See Visualizing Tolerance Analysis Results 

 
See Displaying Tolerance Analysis Results 

 
See Displaying Tolerance Analysis Images 



Customizing

 Before you start your first working session, you can customize the way you work to suit your habits.
This type of customization is stored in permanent setting files: these settings will not be lost if you end your session.

1.  Select the Tools -> Options command.

 The Options dialog box opens.

 
2.  Select the Analysis & Simulation category in the left-hand box.

 
3.  Select the Tolerance Analysis of Deformable Assembly sub-category.

 Three tabs are displayed:

 

 

●     The General tab lets you set the general options.

●     The Fastening tab lets you define the fastening options.

●     The Tolerancing tab lets you set the tolerancing options.

 
4.  Select the Infrastructure category in the left-hand box.

 
5.  Select the Product Infrastructure sub-category.

 One tab also interfere with Tolerance Analysis of Deformable Assembly .

 

 
●     Cache Management

 
6.  Select the Digital Process for Manufacturing category in the left-hand box.

 

 One tab also interfere with Tolerance Analysis of Deformable Assembly .

 
●     Tree

 
7.  Select the Analysis & Simulation category in the left-hand box.

 

 One tab also interfere with Tolerance Analysis of Deformable Assembly .

 
●     External Storage



General 

This page deals with the options concerning:
●     The File Out Folder.

●     The Feature Colors.

●     The Links Creation Mode.

●     The Meshes.

●     The Node and Point Filter.

File Out Folder

Defines the file out folder paths:

External Result Path

Defines the folder path where external results should be saved.

 By default, the value of the CATTemp variable.

Computation Result Path

Defines the folder path where computation results should be saved.

 By default, the value of the CATTemp variable.

Temporary Result Path

Defines the folder path where temporary results should be saved.

 By default, the value of the CATTemp variable.

Feature Colors



Defines the tolerance analysis feature colors:

Rigid Support

Defines the default color of rigid supports.

 By default, the color is magenta. See the screen capture.

Flexible Support

Defines the default color of flexible supports.

 By default, the color is magenta. See the screen capture.

Mechanical joint

Defines the default color of mechanical joints.

 By default, the color is light blue. See the screen capture.

Fastening

Defines the default color of fastening.

 By default, the color is blue. See the screen capture.

Contact

Defines the default color of contacts.

 By default, the color is green. See the screen capture.

Links Creation Mode

Defines the contact link creation mode:

Automatic

Defines whether the links creation can be automatic.
Using the automatic mode, the application takes into account the appropriate contacts around a fastening element. Otherwise, you 
must define the list of contacts taken into account by a given fastening element.

 By default, this option is selected.

Meshes



Defines the meshes options:

Maximum  distance between geometry and point

Defines the maximum distance allowed between a point you defined as a node and the part geometry.
Beyond this distance, the point is not taken into account when the mesh is generated automatically.

 By default, the value is 5mm.

Node and Point Filter

Defines the node and point compatibility with tolerance analysis features:

●     Activate Filter during selection: the application allows you to select nodes and points compatible with the tolerance analysis 
feature.

●     Activate Filter during creation: the application allows you to select nodes and points compatible with the tolerance analysis 
feature.

●     Deactivate Filter: the application checks the validity of the tolerance analysis features when operating the computation.

 By default, the Activate Filter during selection option is selected.



Fastening 

This page deals with the options concerning:
●     The Spot Welding.

●     The Riveting.

●     The Bolting.

●     The Spot Gluing.

Spot Welding

Defines the spot welding options:

Joint type before welding

Defines the mechanical joint taken into account to represent spot welding before a spot welding activity:

●     Point

●     Planar

 By default, the Point representation is selected.

Joint type after welding

Defines the mechanical joint taken into account to represent spot welding after a spot welding activity:

●     Revolute

●     Spherical: only when Point is selected in Joint type before welding.

 By default, the Revolute representation is selected.

Riveting

Defines the riveting options:

Joint type before riveting

Defines the mechanical joint taken into account to represent riveting before a riveting activity:



●     Point

●     Planar

●     Spherical

●     Revolute

 By default, the Point representation is selected.

Joint type after riveting

Defines the mechanical joint taken into account to represent riveting after a riveting activity:

●     Revolute.

●     Spherical: only when Point or Spherical is selected in Joint type before riveting.

 By default, the Spherical representation is selected.

Bolting

Defines the bolting options:

Joint type before bolting

Defines the mechanical joint taken into account to represent bolting before a bolting activity:

●     Point

●     Planar

●     Spherical

●     Revolute

 By default, the Point representation is selected.

Joint type after bolting

Defines the mechanical joint taken into account to represent bolting after a bolting activity:

●     Revolute.

●     Spherical: only when Point or Spherical is selected in Joint type before bolting.

 By default, the Spherical representation is selected.

Spot Gluing



Defines the spot gluing options:

Joint type before gluing

Defines the mechanical joint taken into account to represent spot gluing before a spot gluing activity:

●     Point

●     Planar

 By default, the Point representation is selected.

Joint type after gluing

Defines the mechanical joint taken into account to represent spot gluing after a spot gluing activity:

●     Revolute

●     Spherical: only when Point is selected in Joint type before gluing.

 By default, the Revolute representation is selected.



Tolerancing 

This page deals with the options concerning:
●     The Conversion Range.

●     The Tolerance Translation Reduction Coefficient.

●     The Minimum Variance.

Conversion Range

Defines the conversion range options:

Range

Defines the range value to switch between tolerance interval and statistics law.
For example, with a range value of 3 and applied to a normal law, 99.73% of measures contained in the tolerance interval 
represent the statistics law field.

 By default, the range is 3.

Tolerance Translation Reduction Coefficient

Defines the tolerance translation reduction coefficient options:

Coefficient Value

Defines the coefficient value to translate functional tolerances due to form uncertainty in deviation point grid.

 By default, the coefficient value is 1.

Minimum Variance

Defines the minimum variance options:

Minimum Variance

Defines the percentage value of minimum variance to translate functional tolerances.

 By default, the minimum variance is 50%.



Cache Management for Tolerancing Analysis of 
Deformable Assembly 

This page deals with the options concerning:
●     The Cache Activation.

Cache Activation

Please refer to Infrastructure user's guide to know more about the Product Structure Cache Management options.

Work with the cache system

You must to unselect this option to work with Tolerancing Analysis of Deformable Assembly.

 By default, this option is not selected.



Displaying the Tolerancing Analysis of Deformable 
Assembly's Applicative Data 

This page deals with the options concerning:
●     The Hierarchy tree.

Hierarchy tree

Please refer to Infrastructure user's guide to know more about the Digital Process for Manufacturing Tree options.

Attributes

You need to select this option to display the Tolerancing Analysis of Deformable Assembly's applicative data. 

 By default, this option is not selected.



Disabling the Computation Data Clearing 

This page deals with the options concerning:
●     The Computation Data Management on Save.

Computation Data Management on Save

Please refer to Infrastructure user's guide to know more about the Analysis & Simulation External Storage options.

Automatic clearing of computation data

You must to unselect this option to keep the resulting computation of a tolerance analysis when you save the CATProcess 
document.

 By default, this option is not selected.



Reference Information
This section contains reference information about the Tolerance Analysis of Deformable Assembly workbench.



Transparent Tolerance Analysis

This reference describes how the Tolerance Analysis of Deformable Assembly workbench interprets 
the specifications and results generated with other CATIA and DELMIA workbenches.

Interpreting the Structural Behavior of Product Components

Interpreting Annotation Tolerances

Interpreting Datum Reference Frame



Interpreting the Structural Behavior of Product 
Components

To compute a tolerance analysis, a structural analysis representation is required for each product 
component.

●     When a structural analysis representation does not exist or it is not associated with the product 
component, a new structural analysis representation is automatically created and associated 
with the product component. The creation and association is automatic (and there is no option).
This behavior is only available for CATPart documents.
You may generate the structural analysis representations only by using the Only pre-
processing option in the Compute dialog box. Modify them if necessary from the 
representation created containing the part document in the Generative Structural Analysis 
workbench.

●     When a structural analysis representation exists, you can associate it to its corresponding 
component instance using the Manage representation contextual command. This command lets 
you add the representation from a CATAnalysis document. See the Product Structure 
documentation for more details.

 



Interpreting Annotation Tolerances

When a tolerance analysis is computed, the annotations located on:
●     components in the assembly are interpreted as input variations.

●     assemblies are interpreted as output annotations.

This behavior is only available for V5 annotations associated with a datum reference frame and thin 
parts.
The interpreting operation is automatic. You can define the options using the Tools -> Options 
command. See Tolerancing page.
Semantic annotations such as defined by the ISO ASME/ANSI standards, are taken into account 
only if applied to surfacic component.

 



Interpreting Datum Reference Frames

Instead of using positioning systems, you can use Datum Reference Frame to define correlated 
deviations and distance point-point annotations.
In this case Datum Reference Frames may be assigned as item in a process activity and interpreted 
as positioning system.
Note that Datum Reference Frames do not allow to perform release nor tightening.

 



Tolerance Analysis Data Structure

 

This reference will describe the tolerance analysis data structure. Data is contains in a text file.
This file may contains the tolerance analysis assembly, tolerance analysis resources, the tolerance 
analysis elements, the assembly process.
For more information, see Importing Tolerance Analysis Data.

 The data structure is made of:
●     An introduction, File Header

●     The assembly definition, Tolerance Analysis Assembly

●     The resources definition, Tolerance Analysis Resources

●     The elements definition, Tolerance Analysis Elements

●     The assembly process, Assembly Process

●     A conclusion, File Footer

 The  four main parts may be combined as in the following examples:
●     Tolerance Analysis Assembly only.

●     Tolerance Analysis Assembly + Tolerance Analysis Resources

●     Tolerance Analysis Assembly + Tolerance Analysis Resources+ Tolerance Analysis Elements

●     Tolerance Analysis Assembly + Tolerance Analysis Resources+ Tolerance Analysis Elements + 
Assembly Process



File Header

 

The file header data structure defines settings for data reading.
This part of data structure is mandatory.

Each part or subpart is included between a start tag <xxx> and a end tag <Endxxx>. These tags 
are mandatory.

 <TaaData>

Version: 5700
Mode: English
ModelPath: Absolute
DefineDirections: No
LengthUnit: Millimeter
ForceUnit: Newton

...

  

 <TaaData>

 Start tag of data structure. See File Footer.

 Version: xyzz

 Defines the application data structure version, where:
●     x is the version number.

●     y the release number.

●     zz the service pack number.

 Mode: English or French

 Defines the decimal separator for real number in this file:
●     A point "." for English.

●     A coma "," for French.

 ModelPath: Absolute or Relative

 Defines the path taken into account to read a component, see Path:

●     Absolute sets the component full path.

●     Relative sets the component path from the data file folder.

 LengthUnit: Millimeter 

 Defines the data length unit, Millimeter only.

 ForceUnit: Newton 

 Defines the data force unit, Newton only.



Tolerance Analysis Assembly

 

The tolerance analysis assembly data structure defines the assembly's structure. Assembly 
components are CATPart, CATAnalysis or model.
This part of data structure is mandatory.

Each part or subpart is included between a start tag <xxx> and a end tag <Endxxx>. These tags 
are mandatory.

 ...

<Products>
Number: 2

...

  

 <Products>

 Start tag of tolerance analysis assembly.

 Number: 2

 Defines the number of components.

  

 ...

Name: CurvedPlate
Parent: RootProduct
Instance: No
Path: 
E:\www\awsDocV5R6\TaaEnglish\taaug.doc\src\samples\CurvedPlate.model
Symmetry: No
Positioning:
1.000000 0.000000 0.000000 0.000000 1.000000 0.000000 0.000000 0.000000 
1.000000 0.000000 0.000000 0.000000

...

  

 Name: ComponentName

 Defines the component name.

 Parent: ParentName

 Defines the parent component of the component.

 Instance: No 

 Defines if the component is an instance of component or not, No only.



 Path: PathName 

 Defines the component path according to the ModelPath option.

 Symmetry: No 

 Defines if the component is duplicate by symmetry or not, No only.

 Positioning: PositioningMatrix

 Defines the positioning matrix of the component, the three first columns contain the rotation 
components and the last column the translation components.

  

 ...

<EndProducts>

...

  

 <EndProducts>

 End tag of tolerance analysis assembly.



Tolerance Analysis Resources

 

The tolerance analysis resources data structure defines the resource's structure.
This part of data structure is optional.

Each part or subpart is included between a start tag <xxx> and an end tag <Endxxx>. These tags 
are mandatory.

 ...

<Resources>
Number: 1

...

  

 <Resources>

 Start tag of tolerance analysis resources.

 Number: 1

 Defines the number of resources.

  

 ...

Name: TasResources
Parent: RootResource
Instance: No
NoV4Model
Symmetry: No
Positioning:
1.000000 0.000000 0.000000 0.000000 1.000000 0.000000 0.000000 0.000000 
1.000000 0.000000 0.000000 0.000000
...

  

 Name: ResourceName

 Defines the resource name.

 Parent: ParentName

 Defines the parent resource of the resource.

 Instance: No 

 Defines if the resource is an instance of resource or not, No only.

 NoV4Model 

 Defines the resource as no CATIA V4 model reference.



 Symmetry: No 

 Defines if the resource is duplicated by symmetry or not, No only.

 Positioning: PositioningMatrix

 Defines the positioning matrix of the resource.

  

 ...

<EndResources>

...

  

 <EndResources>

 End tag of tolerance analysis resources.



Tolerance Analysis Elements

The tolerance analysis elements data structure defines the element's structure.
This part of data structure is optional.

Each part or subpart is included between a start tag <xxx> and an end tag <Endxxx>. These tags 
are mandatory.

 The elements are:
●     Supports

●     Joints

●     Positioning Systems

●     Fastenings

●     Contacts

●     Annotations

●     Annotation Bags

 

Supports
 ...

<Supports>
Number: 12

...

  

 <Supports>

 Start tag of tolerance analysis support elements.

 Number: 12

 Defines the number of supports.

  



 ... 

Name: Support.1
Resource: TasResources
NumberOfPoints: 1
Stiffness: Rigid
PointName: SUP1
Coordinates: 0.000000 0.000000 0.000000

Name: Support.2
Resource: TasResources
NumberOfPoints: 2
Stiffness: Flexible
PointName: SUP2
Coordinates: 500.000000 0.000000 0.000000
PointName: SUP3
Coordinates: 500.000000 -50.000000 0.000000
StiffnessesKind: Element
Stiffnesses: 1000.000000 10000000000.000000 300.000000 10000000000.000000
Zdirection: 0.000000 0.000000 1.000000

...

  

 Name: SupportName

 Defines the support name.

 Resource: ResourceName

 Retrieves the resource associated with the support from its name.

 NumberOfPoints: 1 

 Defines the number of points defining the support.

 Stiffness: Rigid or Flexible 

 Defines the support stiffness.

 PointName: SUP1 

 Defines the point name where to create the support.

 Coordinates: 0.000000 0.000000 0.000000

 Defines the point coordinates where to create the support.

 [StiffnessesKind: Element or Rectangular or Circular ] optional

 Defines the beam section between two points of the support.

 [Stiffnesses: 1000.000000 10000000000.000000 300.000000 10000000000.000000] 
optional

 Defines the beam stiffness between two points of the support.
Use only with Flexible option in Stiffness and Element option in StiffnessesKind.



 [Young Module: .216e6] optional

 Defines the beam section Young module.
Use only with Flexible option in Stiffness and Circular or Rectangular option in StiffnessesKind.

 [Poisson Coefficient: 0.3] optional

 Defines the beam section Poisson coefficient.
Use only with Flexible option in Stiffness and Circular or Rectangular option in StiffnessesKind.

 [Base, Height: 3.000000 2.000000] optional

 Defines the beam rectangular section base and height.
Use only with Flexible option in Stiffness and Rectangular option in StiffnessesKind.

 [Radius: 2.000000] optional

 Defines the beam circular section radius.
Use only with Flexible option in Stiffness and Circular option in StiffnessesKind.

 [Zdirection: 0.000000 0.000000 1.000000 or NoZdirection] optional 

 Defines the Z direction for the beam profile between two points of the support if this profile is not 
circular,
no Z direction is needed when the profile is circular.
Use only with Flexible option in Stiffness and Element or Rectangular option in StiffnessesKind.

  

 ...

<EndSupports>

...

  

 <EndSupports>

 End tag of tolerance analysis support elements.

  

 

Joints
 ...

<Joints>
Number: 12

...

  

 <Joints>

 Start tag of tolerance analysis joint elements.



 Number: 12

 Defines the number of joints.

  

 ...

Name: Joint.1
Type: Spherical
Between: CurvedPlate TasResources
PointName: ST1
Coordinates: 0.000000 0.000000 0.000000
Xdirection: 1.000000 0.000000 0.000000
Zdirection: 0.000000 -0.992710 0.120527

...

  

 Name: JointName

 Defines the joint name.

 Type: TypeName

 Defines the joint type name: 

 
●     Point for point joint.

●     AnnularLinear for annular-linear joint.

●     EdgeSlider for edge Slider joint.

●     Planar for planar joint.

●     Spherical for spherical joint.

●     SphericalWithPin for spherical with pin joint.

●     Cylindrical for cylindrical joint.

●     Screw for screw joint.

●     Revolute for revolute joint.

●     Prismatic for prismatic joint.

●     Rigid for rigid joint.

 Between: ReferenceName1 ReferenceName2

 Retrieves the two references associated with the joint from their names.
The references must be two components or a component and a resource or a component and a 
support.

 [PointName: ST1] optional

 Defines the point name where to create the joint.
Do not use when a support is used as reference.

 [Coordinates: 0.000000 0.000000 0.000000] optional



 Defines the point coordinates where to create the joint.
Do not use when a support is used as reference.

 Xdirection: 1.000000 0.000000 0.000000

 Defines the X direction for the joint.

 [Zdirection: 0.000000 -0.992710 0.120527] optional

 Defines the Z direction for the joint.
Use only with joint type different from Point option in Type.

  

 ...

<EndJoints>

...

  

 <EndJoints>

 End tag of tolerance analysis joint elements.

  

 

Positioning Systems
 ...

<PositioningSystems>
Number: 4

...

  

 <PositioningSystems>

 Start tag of tolerance analysis positioning system elements.

 Number: 4

 Defines the number of positioning systems.

  



 ...

Name: PositionSys1
NumberOfJoints: 6
JointName: Joint.1
Tightening: 0
JointName: Joint.2
Tightening: 0
JointName: Joint.3
Tightening: 0
JointName: Joint.4
Tightening: 0
JointName: Joint.5
Tightening: 0
JointName: Joint.6
Tightening: 0

...

  

 Name: PositioningSystemName

 Defines the positioning system name.

 NumberOfJoints: 6 

 Defines the number of joints defining the positioning system.

 JointName: JointName

 Retrieves the joint associated with the positioning system from its name.

 Tightening: 0 either Release: 2

 For example, according to the table below to tighten or release the three rotations Rx, Ry and Rz, 
add up the value associated with them: 8+16+32 = 56 to define the tightening or release value.
Note: Tightening: 0 means no tightened neither released translation or rotation, and Release: 0 
does not exist.

 
Tx Ty Tz Rx Ry Rz

1 2 4 8 16 32

  

 ...

<EndPositioningSystems>

...

  

 <EndPositioningSystems>

 End tag of tolerance analysis positioning system elements.



  

 

Fastenings
 ...

<Fastenings>
Number: 4
DefineDirections: Yes

...

  

 <Fastenings>

 Start tag of tolerance analysis fastening elements.

 Number: 4

 Defines the number of fastenings.

 DefineDirections: Yes or No 

 Allows the deviation directions to be different from node normal directions: 

 
●     Yes to define new directions.

●     No to use node normal directions.

  

 ...

Name: SpotWelding.1
Type: SpotWelding
Diameter: 5.000000
Between: CurvedPlate Plate
PointName: SW1
Coordinates: 0.000000 875.000000 500.000000

...

  

 Name: FasteningName

 Defines the fastening name.

 Type: FasteningType

 Defines the fastening type:



 
●     SpotWelding for spot welding.

●     Riveting for riveting.

●     Bolting for bolting.

●     SpotGluing for spot gluing.

 Diameter: 5.000000 

 Defines the fastening diameter.

 Between: ReferenceName1 ReferenceName2

 Retrieves the two references associated with the fastening from their names.
The references must be two components. 

 PointName: PointName

 Defines the point name of the fastening.

 Coordinates: 0.000000 875.000000 500.000000

 Defines the point coordinates of the fastening.

 [Direction: 0.000000 0.000000 1.000000] optional

 Defines the fastening direction.
Use only with Yes option in DefineDirections.

  

 ...

<EndFastenings>

...

  

 <EndFastenings>

 End tag of tolerance analysis fastening elements.

  

 

Contacts
 ...

<Contacts>
Number: 1
DefineDirections: Yes

...

  

 <Contacts>



 Start tag of tolerance analysis contact elements.

 Number: 2

 Defines the number of contacts.

 DefineDirections: Yes or No

 Allows the deviation directions to be different from node normal directions: 

 
●     Yes to define new directions.

●     No to use node normal directions.

  

 ... 

Name: Contact.1
NumberOfPoints: 8
Between: CurvedPlate Plate
PointName: Cont61
Coordinates: 0.000000 750.000000 500.000000
PointName: Cont63
Coordinates: 250.000000 750.000000 500.000000
PointName: Cont65
Coordinates: 500.000000 750.000000 500.000000
PointName: Cont68
Coordinates: 125.000000 875.000000 500.000000
PointName: Cont70
Coordinates: 375.000000 875.000000 500.000000
PointName: Cont72
Coordinates: 0.000000 1000.000000 500.000000
PointName: Cont75
Coordinates: 250.000000 1000.000000 500.000000
PointName: Cont76
Coordinates: 500.000000 1000.000000 500.000000

...

  

 Name: ContactName

 Defines the contact name.

 NumberOfPoints: 8

 Defines the number of contact points.

 Between: ReferenceName1 ReferenceName2

 Retrieves the two references associated with the contact from their name.
The references must be two components.

 PointName: PointName



 Defines a point  name of the contact.

 Coordinates: 0.000000 750.000000 500.000000

 Defines a point coordinates of the contact.

 [Direction: 0.000000 0.000000 1.000000] optional

 Defines the contact direction.
Use only with Yes option in DefineDirections.

  

 ...

<EndContacts>

...

  

 <EndContacts>

 End tag of tolerance analysis contact elements.

  

 

Annotations
 ...

<Annotations>
Number: 3
DefineDirections: No

...

  

 <Annotations>

 Defines the number of annotation sets.

 Number: 3

 Defines the number of annotation sets.

 DefineDirections: Yes or No 

 Allows the deviation directions to be different from node normal directions: 

 
●     Yes to define new directions.

●     No to use node normal directions.

  



 ...

Name: TPSSet1
ProductName: CurvedPlate
NumberOfToleranceTypes: 1
ToleranceType: Deviation
NumberOfTolerances: 7
PositioningSystem: PositionSys3
Law: Normal
ToleranceName: Dev.1
PointName: *PT4
Coordinates: 0.000000 500.000000 500.000000
ToleranceName: Dev.2
PointName: *PT5
Coordinates: 250.000000 500.000000 500.000000
ToleranceName: Dev.3
PointName: *PT6
Coordinates: 500.000000 500.000000 500.000000
ToleranceName: Dev.4
PointName: *PT7
Coordinates: 0.000000 875.000000 500.000000
ToleranceName: Dev.5
PointName: *PT8
Coordinates: 250.000000 875.000000 500.000000
ToleranceName: Dev.6
PointName: *PT9
Coordinates: 500.000000 875.000000 500.000000
ToleranceName: Dev.7
PointName: *PT80
Coordinates: 250.000000 0.000000 0.000000

...

  

 Name: AnnotationName

 Defines the annotation set name.

 ProductName: ComponentName

 Retrieves the component associated with the annotation set from its name.

 NumberOfToleranceTypes: 1

 Defines the number of tolerance type used, deviation and/or correlated deviation only and/or 
distance between two points.

 ToleranceType: Deviation or CorrelatedDeviation or DistancePtPt

 Defines the tolerance type: 



 
●     Deviation for deviation.

●     CorrelatedDeviationfor correlated deviation.

●     DistancePtPt for distance between two points.

 NumberOfTolerances: 7

 Defines the number of tolerance of the tolerance type.

 PositioningSystem: PositioningSystemName

 Retrieves the positioning system associated with the annotation type from its name.

 Law: Normal or Uniform or Constant or Poisson or Pearson or Snedecor or Sample

 Defines the statistic law associated with the tolerance type.
Use only Normal, Uniform, Constant, Poisson, Pearson and Snedecor laws with Deviation or 
DistancePtPt option in ToleranceType.
Use only Sample law with CorrelatedDeviation option in ToleranceType

 [SampleFile: No or PathFileName] optional

 Defines the absolute path and filename containing the correlated deviation law or not.
Use only with CorrelatedDeviation option in ToleranceType.

 [Mean: 1.] optional

 Defines the means in Normal law.
Use only with Normal option in Law.

 [Standard Deviation: 0.1] optional

 Defines the standard deviation in Normal law.
Use only with Normal option in Law.

 [MinValue: -1.] optional

 Defines the minimal value in Uniform law.
Use only with Uniform option in Law.

 [MaxValue: 1.] optional

 Defines the maximal value in Uniform law.
Use only with Uniform option in Law.

 [Constant: 1.] optional

 Defines the constant value in Constant law.
Use only with Constant option in Law.

 [Lambda: 5] optional

 Defines the lambda value in Poisson law.
Use only with Poisson option in Law.

 [Nu: 1.] optional

 Defines the nu value in Pearson law.
Use only with Pearson option in Law.



 [DOF_m: 4] optional

 Defines the dof m value in Snedecor law.
Use only with Snedecor option in Law.

 [DOF_n: 5] optional

 Defines the dof n value in Snedecor law.
Use only with Snedecor option in Law.

 ToleranceName: ToleranceName

 Defines a tolerance name of the tolerance type.

 PointName: PointName

 Defines a point name of the tolerance type.

 Coordinates: 0.000000 750.000000 500.000000

 Defines a point coordinates of the tolerance type.

 [Direction: 0.000000 0.000000 1.000000] optional

 Defines the annotation direction.
Use only with Yes option in DefineDirections.

  

 ...

<EndAnnotations>

...

  

 <EndAnnotations>

 End tag of tolerance analysis annotation set elements.

  

 

Annotation Bags
 ...

<AnnotationBags>
Number: 2

...

  

 <AnnotationBags>

 Start tag of tolerance analysis annotation bags.

 Number: 2



 Defines the number of annotation bags.

  

 ...

Name: TPSBag1
SetName: TPSSet3
NumberOfTolerances: 14
Dev.1 Dev.2 Dev.3 Dev.4 Dev.5 Dev.6 Dev.7 Dev.8 Dev.9 Dev.10 Dev.11 
Dev.12 Dev.13 Dev.14

Name: TPSBag2
SetName: TPSSet3
NumberOfTolerances: All

...

  

 Name: AnnotationBagName

 Defines the annotation bag name.

 SetName: AnnotationName

 Retrieves the annotation set associated with the annotation bag from its name.

 NumberOfTolerances: 14 or All

 Defines the number of tolerance of the annotation set: 

 
●     A number to define a subset of annotations contain in the annotation set.

●     All to retrieve all annotations contain in the annotation set.

 [ToleranceName1 ToleranceName2 ToleranceName3 ... ] optional

 Retrieves the tolerances associated with the annotation bag from their names.
Use only with a numerical value option in NumberOfTolerance.

  

 ...

<EndAnnotationBags>

...

  

 <EndAnnotationBags>

 End tag of tolerance analysis annotation bag elements.



Assembly Process

The assembly process data structure defines the process's structure.
This part of data structure is optional.

Each part or subpart is included between a start tag <xxx> and an end tag <Endxxx>. These 
tags are mandatory.

 

Assembly Process
 ...

<AssemblyProcess>
Number: 5

...

  

 <AssemblyProcess>

 Start tag of assembly process.

 Number: 5

 Defines the number of assembly activities.

  

 ...

Name: Activity.1
Activity: POSITIONING
PreviousActivities: No
PositioningSystems: PositionSys1 PositionSys2
Fastenings: No
TolerancingBag: TPSBag1

...

  

 Name: ActivityName

 Defines the activity name.

 Activity: ActivityType

 Defines the activity type:
●     POSTIONING for positioning activity.

●     FASTENING for fastening activity.

●     RELEASE for release activity.



 PreviousActivities: Activity1 Activity2 ... or No 

 Retrieves the previous activities before this one from their name:
●     A list of activity names.

●     No when there is no previous activity.

 PositioningSystems: PositioningSystemName1 PositioningSystemName2 ... 

 Retrieves the positioning system names associated with the activity.

 Fastenings: FasteningName1 FasteningName2 or No

 Retrieves the fastening names associated with the activity from their name:
●     A list of fastening names when the activity type is FASTENING. See Activity.

●     No when the activity type is not FASTENING. See Activity.

 TolerancingBag

 Retrieves the tolerancing bag associated with the activity from its name.

  

 ...

<EndAssemblyProcess>

...

  

 <EndAssemblyProcess>

 End tag of assembly process.



File Footer

The file footer data structure defines the end of data reading.
This part of data structure is mandatory.

Each part or subpart is included between a start tag <xxx> and an end tag <Endxxx>. These 
tags are mandatory.

 ...

<EndTaaData>

<EndTaaData>

End tag of data structure. See File Header.



Measurement Data

Measurement file data structure are contain in a text file. This file contains the measure 
specifications for an analysis geometric variations annotation.

 <TaaData> 

Version: 5700
Mode: English
LengthUnit: Millimeter
...

  

 <TaaData>

 Start tag of data structure.

 Version: xyzz

 Defines the application data structure version, where:

 x is the version number.

 y the release number.

 zz the service pack number.

 Mode: English or French

 Defines the decimal separator for real number in this file:

 A point "." for English.

 A coma ","for French.

 LengthUnit: Millimeter 

 Defines the data length unit, Millimeter only.

  

 ... 

<Measures>
NumberOfVariables: 7
NumberOfMeasures: 10

...

  

 <Measures>

 Start tag of measures.



 NumberOfVariables: 7

 Defines the number of variables.

 NumberOfMeasures: 10

 Defines the number of measures.

 0.2 0.1 0.1 0.1 0.1 0.1 0.1 

 0.1 0.1 0.1 0.1 0.1 0.1 0.1

 0.1 0.1 0.1 0.1 0.1 0.1 0.1

 0.1 0.1 0.1 0.1 0.1 0.1 0.1

 0.1 0.1 0.1 0.1 0.1 0.1 0.1

 -.1 -.1 -.1 -.1 -.1 -.1 -.1

 -.1 -.1 -.1 -.1 -.1 -.1 -.1

 -.1 -.1 -.1 -.1 -.1 -.1 -.1

 -.1 -.1 -.1 -.1 -.1 -.1 -.1

 -.1 -.1 -.1 -.1 -.1 -.1 -.1

 Matrix where rows represent measures and columns represent variables.

  

 ...

<EndPMeasures>

...

  

 <EndMeasures>

 End tag of measures.

  

 ... 

<EndTaaData> 

  

 <EndTaaData>

 End tag of data structure.

 



Statistic Laws

 
Statistic laws are used to characterize deviation annotations. interpret annotation tolerance in a 
deviation annotation. These deviation annotations can be directly specified by the user or generated 
from a annotation's tolerance translation.

 For a statistical analysis, an annotation tolerance is interpreted as random variable or 
variate.

 For a determinist analysis, the mean of the annotation tolerance  is used as determinist 
value.

 Normal Law: describe the Normal probability law equations.

 Uniform Law: describe the Uniform probability law equations.

 Constant Law: describe the Constant probability law equations.

 Pearson Law: describe the Pearson probability law equations.

Poisson Law: describe the Poisson probability law equations.

Snedecor Law: describe the Snedecor probability law equations.



Normal Law 

 

The Normal law is parameterized by a mean  (unit: millimeter) and a standard deviation  (unit: 
millimeter). Another name for the Normal law is Gaussian law.

 

 Let's take  a random variable following the Normal law, then:

 is distributed according to the following density of probability:

 

With mean:

 

With variance:

 

With standard deviation:

 



Uniform Law 

 

The Uniform law is parameterized by a lower limit  (unit: millimeter) and a upper limit  (unit: 
millimeter). Another name for the Uniform law is Rectangular law.

 

 Let's take  a random variable following the Uniform law, then:

 is distributed according to the following density of probability, where:

 

With mean:

 

With variance:

 

With standard deviation:

 



Constant Law 

 

The Constant law is parameterized by a constant  (unit: millimeter). 

 

 Let's take  a random variable following the Constant law, then:

 is always equals to the constant:

 

With mean:

 

With variance:

 

With standard deviation:

 



Pearson Law 

 

The Pearson law is parameterized by  (no unit). Another name for the Pearson law is Chi-squared 
law.
If  random variables  follows the Normal law with mean 0 and variance 1, then:

 

 

 
Let's take  a random variable following the Pearson law, then:

 is distributed according to the following density of probability, where:

 

And where  is a Gamma function.

With mean:

 

With variance:

 

With standard deviation:

 



Poisson Law 

 

The Poisson law is parameterized by  (unit: millimeter).

 

 Let's take  a random variable following the Poisson law, then:

 is distributed according to the following density of probability, where:

 

With mean:

 

With variance:

 

With standard deviation:

 



Snedecor Law 

 

The Snedecor law is parameterized by two non-dimensional numbers  and .

 

 Let's take  a random variable following the Snedecor law of parameters  and , then  can 

be expressed in terms of two random variables ,  following Pearson law respectively of 
parameter ,  as:

 

 is distributed according to the following density of probability, where:

 

With mean:

 

With variance:

 

With standard deviation:

 



Interface Description

This reference details Tolerance Analysis of Deformable Assembly interface.

 Image Edition Dialog Box

 Advanced Edition for Images and Local Sensors



Image Edition

This task describes the Image Edition dialog box.

The names of the images depend on:

1.  physical type (for example: Displacement)
2.  visualization type (for example: Symbol or Text)
3.  criterion (for example: Norm or Vector component)

You will find in the following table the available tabs and buttons in the Image Edition dialog box.

 Mono-occurrence solutions Multi-occurrence solutions 

Deformed Mesh image

Mesh Visualization image

Mesh

Selections

Preview

Mesh

Selections

Occurrences

Preview

Other images

Visu

Selections

More

Preview

Visu

Selections

Occurrences

More

Preview

 

Mesh Tab
 



●     On deformed mesh: lets you visualize results in deformed mode.

In the case of Dynamic Response Analysis Case (Harmonic or Transient) with restraint 

excitation, you can specify if you want to visualize the image in an absolute axis (Absolute 

option) or in a relative axis (Relative option).

❍     Absolute: lets you visualize both the displacement and the elastic deformation of the 
part.

❍     Relative: lets you visualize only the elastic deformation of the part.

●     Display free nodes: lets you display free nodes (nodes that are referenced by any element).

●     Display nodes of elements: lets you visualize nodes of elements.

●     Display small elements: lets you choose to display or not the very small elements.

●     Shrink Coefficient: lets you shrink the element visualization.

 

Visu Tab



 

●     On deformed mesh: lets you visualize the deformation.

In the case of Dynamic Response Analysis Case (Harmonic or Transient) with restraint 

excitation, you can specify if you want to visualize the image in an absolute axis (Absolute 

option) or in a relative axis (Relative option).

❍     Absolute: lets you visualize both the displacement and the elastic deformation of the 
part.

❍     Relative: lets you visualize only the elastic deformation of the part.

●     Type: provides a list with visualization types (how).
The list of visualization types depends on the selected image.

❍     Average iso: lets you visualize isolines at nodes.

This visualization type uses the Material Rendering capabilities.

❍     Discontinuous iso: lets you visualize isolines at nodes of element.

This visualization type uses the Material Rendering capabilities.

❍     Fringe: lets you color an element, a face of element or an edge of element according to the 
scalar value defined for this entity.



❍     Text: lets you visualize results using text.

❍     Symbol: lets you visualize results using symbol.
The available symbols depend on the values to be displayed.

●     Criteria: provides a list of visualization criteria.
The list of visualization criteria depends on the physical type of the selected image and the selected 
Type.

●     Options...: lets you define visualization options.

Only available if you installed the ELFINI Structural Analysis product.

The dialog box that appears depends on the Type option you previously selected.

For more details about this button, please click here.

Options... button

Here you will find the available visualization options you obtain using the Options... button: 

 

●     if you selected the Discontinuous iso, Average iso or Fringe type, the Visualization Options 
dialog box appears as shown bellow: 

❍     Shrink Coefficient: lets you shrink the element visualization

❍     Display elements without value: lets you display elements with or without value

❍     Display small elements: lets you choose to display or not the very small elements

This option is only available if you selected the Fringe type.

●     if you selected the Symbol type, the Visualization Options dialog box appears as shown bellow:



❍     Type: 
■     Representation: lets you choose between the symbol representation types. The number of 

the available representations depends on the visualization Type and Criteria.

❍     Color: 
■     Imposed: enables the color to be fixed.

If this option is selected, you can use the Color Chooser.

❍     Size: 
■     Minimum length: lets you define the minimum symbol length.

■     Maximum length: lets you define the maximum symbol length.

■     Variable: enables the variability of the symbols in function of the value.

■     Zoom sensitive: enables the length of the symbols to be zoom sensitive.

●     if you selected the Text type, the Visualization Options dialog box appears as shown bellow:

❍     Color: 
■     Imposed: enables the color to be fixed.

If this option is selected, you can use the Color Chooser.
 



 

Selections Tab
 

The Selections tab lets you limit the image visualization to a list of entities.

●     Available Groups: gives you the list of the available entities.

The available entities could be:

❍     mesh parts (under the Nodes & Elements set in the specification tree)

❍     pre-processing specifications (under the Restraints, Loads and Masses sets in the specification 
tree)

❍     user groups (under the Groups set in the specification tree)

You can filter the list of the available entities using the Filter groups... contextual menu.

For more details, please click here.

●      button: lets you activate the visualization of all the available entities contained in the Available 
Groups frame.

●      button: lets you activate the visualization of entities selected in the Available Groups frame.

●      button: lets you deactivate the visualization of entities selected in the Activated Groups 



frame.

●      button: lets you lets you deactivate the visualization of all the selected entities contained in the 
Activated Groups frame.

●     Activated Groups: shows you the list of the entities you have activated the visualization.
 

●     Multi-selection is available.
In this case, the resultant selection is the union of the selected entities.

●     You can double-click an entity to activate or deactivate the entity visualization.

●     You can select entities directly in the specification tree or in the viewer.

●     Minimum value and the maximum value of the color palette depend on the selected entities.

●     If the Activated Groups field is empty, all the entities listed in the Available Groups field 
will be visualized.

In case of pre-processing specifications, the type of entities contained in a selection may be 

different from a specification to another.

For example:

●     a Clamp symbolizes a list of nodes

●     a Lineic Force symbolizes a list of edges

●     a Pressure symbolizes a list of faces

Filtering Groups

a.  Right-click in the Available Groups frame and select the Filter Groups... contextual menu as 

shown bellow: 

The Filter Groups dialog box appears.



❍     User groups: lets you activate all the groups under the Groups set in the specification tree.

❍     1D mesh parts: lets you activate all the 1D mesh parts under the Nodes and Elements 
set in the specification tree.

❍     2D mesh parts: lets you activate all the 2D mesh parts under the Nodes and Elements 
set in the specification tree.

❍     3D mesh parts: lets you activate all the 3D mesh parts under the Nodes and Elements 
set in the specification tree.

❍     Connection mesh parts: lets you activate all the connection mesh parts under the Nodes 
and Elements set in the specification tree.

❍     Specification groups: lets you activate all the entity under the Restraints, Loads and 
Masses sets in the specification tree.

b.  Set the desired options.

c.  Click OK in the Filter Groups dialog box.

For example, with the following analysis specification tree:



●     if you activate the User groups and the Specification groups options, the Available Groups 

frame is updated as shown bellow:

●     if you activate the 3D mesh parts and the Specification groups options, the Available Groups 

frame is updated as shown bellow:



 

Occurrences Tab

The Occurrences tab is available in the Image Edition dialog box only for multi-occurrence solutions.

This tab gives you the list of modes with the associated:

●     frequencies (Hz) for a Frequency Case and a Harmonic Dynamic Response Case

●     Buckling factor for a Buckling Case



●     Time (s) for a Transient Dynamic Response Case



You can then activate separately each mode of the multi-occurrence solution.

 

More and Less Buttons
 

For more details on Values and Filters options, please click here.

Preview button



 
By default, the visualization process is launched after each modification in the Image Edition dialog box.

The Preview button allows you to launch the visualization process after performing all the needed 

changes in the Image Edition dialog box.

The Preview button is available only if you deactivate the Automatic preview mode option in 

the Options dialog box (Tools -> Options... menu).

For more details, please refer to the Customizing - Post Processing section of the Generative 

Structural Analysis User's Guide.



Advanced Edition for Images and Local Sensors

This task describes the advanced edition of the values that are taken into account for the 

visualization (advanced edition of images) or for the local sensors.

●     Values:

❍     Position

❍     Value type

❍     Complex part

❍     Do not combine

●     Filters:

❍     Show filters for

❍     Axis system

❍     Display locally

❍     Component

❍     Layer

❍     Lamina

❍     Ply id



 
Values

 

●     Position: the position depends on the selected Type and Criteria option in the Visu tab.

Node Linked to the mesh nodes.

For each node, there is only one value.

Node of element For each node, there is as many values as elements linked to this 

node.

Center of element For each element center, there is only one value.

Edge of element For each edge element, there is only one value.

Face of element For each face element, there is only one value.

Element For each element, there is only one value.

Gauss point of element The position of the Gauss points depend on the type of element.

For more details, please refer to the Finite Element Reference 

Manual.

"(from solver)" indicates that the position is provided by the solver.

To know more about the authorized position according to a selected Visu Type, please refer to 
the Frequently Asked Section - Post-Processing and Visualization section of the Generative 



Structural Analysis User's Guide.
 

●     Value type: corresponds to the type of the value (integer, real, double precision, complex, 
complex with double precision).

●     Complex part: the complex part is available when the selected Value Type is complex and 
complex with double precision.

●     Do not combine: 
❍     if this option is not activated, combined values will be displayed whenever available. The 

desired resulting force will be displayed.

❍     if this option is activated, each specification (force, restraints and so forth) can be displayed 
separately. You will use the Value set list box to choose the desired value set.

For example, if three forces were applied on a single surface, three values will be available in 
the Value set combo box. You can then select the desired Value set.

 
Filters

 

●     Show filters for: lets you select the entity type on which you will change the Axis System, 
Component, Layer, Lamina and Ply id options.

The Show filters for option does not modify the feature you are editing.

The following options are available:

❍     Nodes of 1D elements, Nodes of 2D elements or Nodes of 3D elements for a Node 
position type.

❍     1D elements, 2D elements or 3D elements for an Element position type.
 

●     Axis System: lets you select the current axis system to be used.
For this, click the ... button.



❍     The Axis system functionality is only available if you installed the ELFINI 

Structural Analysis (EST) product.

❍     The ... button is only available if you have selected Vector, Tensor, Vector 

component or Tensor component as Criteria option.

❍     Global: lets you select the main axis system.

❍     User: lets you select an axis system feature (created in the Part Design workbench or the 
Generative Shape Design workbench).

❍     Manual: lets you specify an axis system by defining the origin coordinates and the different 
directions.



❍     Local: lets you select an axis system that is locally defined (related to a finite element).

●     Display locally: lets you visualize the axis on each entity.

The Display locally functionality is only available

❍     if you installed the ELFINI Structural Analysis (EST) product.

❍     in the image edition context.



❍     Display locally option deactivated with a Global axis system

❍     Display locally option activated with a Global axis system

●     Component: lets you select the component to visualize.



❍     For example, if you select a Translational displacement symbol image, you will get the 

following Component options: 

■     ALL: all the components

C1:  components according to x in the current axis system  

C2:  components according to y in the current axis system

C3:  components according to z in the current axis system

You can also have a combination of these components (for example, C1 & C2).

❍     For Stress principal tensors image:

■     In the case of 3D elements:

C11:  is the maximum principal stress 

C22:  is the middle principal stress

C33:  is the minimum principal stress

You can also have a combination of these components (for example, C11 & C22).

■     In the case of 2D elements:

C1:  is the maximum principal stress

C2:  is the minimum principal stress

●     Layer: (only available in the case of 2D elements).
In a lamina, you can select the  Upper, Middle or Lower layer from which the results will be 
computed.

If you installed the ELFINI Structural Analysis (EST) product, you can display both 

the upper and lower layers according to local normal orientation using the Upper and 

lower option.

●     Lamina: (only available in the case of 2D elements with composite property).

You can select the Lamina from which the results will be visualized.

●     Ply id: (only available in the case of 2D elements with composite property).

You can select the Ply id from which the results will be visualized.



Glossary  

        

A
 

active component A selected component currently being edited. This component is underlined in 
the specification tree.

assembly An entity composed of various components which have been positioned relative 
to each other.

 

C
 

child component One or more components originating from a single component. Compare 
parent component.

compatible meshes Meshes assembly where mesh nodes of the different meshes are coincident.

component A reference integrated in an assembly. A component possesses characteristics 
related to how it is integrated in an assembly (for example, its relative location 
in an assembly).

 

I
 

incompatible Meshes Meshes assembly where mesh nodes of the different meshes are not 
coincident.

 

L
 

leaf component The last component at the end of each branch of the specification tree.

 



M
 

model A CATIA Version 4 model.

 

P
 

parent component A component that is hierarchically just above one or more components. 
Compare child component.

part Within the Assembly workbench, it is either a part of the Part Design 
workbench, or a 3D entity whose geometry is contained in a model.

primary child
component

One or more components originating from the first level under the active 
component.

product A 3D entity which contains several components.

 

R
 

reference A product or part with its own characteristics. Compare component.

 

S
 

subassembly An assembly contained within another assembly.
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